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Legal Information

The Pro-face brand and any trademarks of Schneider Electric SE and its subsidiaries
referred to in this guide are the property of Schneider Electric SE or its subsidiaries.
All other brands may be trademarks of their respective owners.

This guide and its content are protected under applicable copyright laws and
furnished for informational use only. No part of this guide may be reproduced or
transmitted in any form or by any means (electronic, mechanical, photocopying,
recording, or otherwise), for any purpose, without the prior written permission of
Schneider Electric.

Schneider Electric does not grant any right or license for commercial use of the guide
or its content, except for a non-exclusive and personal license to consult it on an "as
is" basis. Schneider Electric products and equipment should be installed, operated,
serviced, and maintained only by qualified personnel.

As standards, specifications, and designs change from time to time, information
contained in this guide may be subject to change without notice.

To the extent permitted by applicable law, no responsibility or liability is assumed by
Schneider Electric and its subsidiaries for any errors or omissions in the informational
content of this material or consequences arising out of or resulting from the use of the
information contained herein.

As part of a group of responsible, inclusive companies, we are updating our
communications that contain non-inclusive terminology. Until we complete this
process, however, our content may still contain standardized industry terms that may
be deemed inappropriate by our customers.

Cybersecurity Best Practices

To help keep your Pro-face products secure and protected, we recommend that
you implement the cybersecurity best practices. Following the recommendations
may help significantly reduce your company’s cybersecurity risk. For the
recommendations, refer to the following URL:
https://www.pro-face.com/trans/en/manual/1087.html



Safety Information

Important Information

Please Note

Read these instructions carefully, and look at the equipment to become familiar
with the device before trying to install, operate, service, or maintain it. The
following special messages may appear throughout this documentation or on the
equipment to warn of potential hazards or to call attention to information that
clarifies or simplifies a procedure.

The addition of this symbol to a “Danger” or “Warning” safety label indicates that an
electrical hazard exists which will result in personal injury if the instructions are not
followed.

hazards. Obey all safety messages that follow this symbol to avoid possible injury or
death.

A DANGER

DANGER indicates a hazardous situation which, if not avoided, will result in death or serious
injury.

2 This is the safety alert symbol. It is used to alert you to potential personal injury

A WARNING

WARNING indicates a hazardous situation which, if not avoided, could result in death or
serious injury.

A CAUTION

CAUTION indicates a hazardous situation which, if not avoided, could result in minor or
moderate injury.

NOTICE

NOTICE is used to address practices not related to physical injury.

Electrical equipment should be installed, operated, serviced, and maintained only
by qualified personnel. No responsibility is assumed by Schneider Electric for any
consequences arising out of the use of this material.

A qualified person is one who has skills and knowledge related to the construction
and operation of electrical equipment and its installation, and has received safety
training to recognize and avoid the hazards involved.
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Template User Guide

.BLUE Open Studio Bl Dashboard

Introduction

This document describes the features of the Dashboard Template application, and contains a manual the user can
follow to use the application, connecting and configuring a Data Source, creating a Dashboard and its objects, and
generate reports for that Dashboard.

Comments

General:

The software shall provide the necessary tools to allow a user to create a Dashboard based on the queries created.

Electronic Signatures (Security System)

The system administrator must be able to access the user account settings to create new accounts, lockout users, and
de-authorize them.

Nobody (not even the System Administrator) can have access to the password of any user.
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Overview and Application Layout

This section describes the Overview and Application Layout of the Dashboard Template

Header
#%, Home ol M _ Switch N Exit
Screen ‘ ._‘__J [lachhoan !Eﬂ EZUSEr... H (= e H X Application

08/15/2012
Fome

This button opens the Home Screen of the application, where you can install the Chart Control Objects.

1. Home Screen

2. Dashboard

This button opens the Dashboard screen, where you can see the selected Dashboard.

3. Report

This button opens the Report screen, where you can create a report for the selected dashboard, save and/or print it.

4. Switch User

This button opens the Logon screen, there you can change the user connected to the application, and edit the users
configured for the application.

5. License
This button opens the License popup and informs the user that:
"This version of the Business Intelligence Dashboard Template requires only a license for the HMI/SCADA product
running it".

6. Exit Application

This button is used to exit the application, finishing all the background tasks from Proface.

Status Bar

= English | CSBSP2012000005 | 192.168.100.158 DB Connection Ok, | System Running Guest V7.0
1. Language Screen

The user can open the popup to select the Application Language, and choose between 8 languages for this application.
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2. Web Client

The user can access the web client for the application by clicking on the second and third buttons on the status bar
(Computer name and Computer IP address).

3. Database Status
On the Database Status screen, the user can check the connection to the Databases configured for the application.
The user can check if there’s a connection, and if it's working or there’s an error to connect to this Database.
4. System Status
The user can also check the application status, it's possible to see what task the system is running at the moment.
5. Log On

The user can use the status bar to open the Logon popup, where it's possible to switch the user connected to the
application or Log Off.

Tree View
) -
Menu Panel 49 » i

& ] Project Demo

El Data Sources

EIL_?_] Data Source Demo
-2 Design Query | MNew
P e 7+ SQL QLIEF_‘,I'
=, Dashboards o o
: n
= || Dashboard Demo ] E pe
----- B 1-Chartl

The Tree View is where the user can create projects with the Dashboards wanted. The user can open the tree view by
clicking on the arrow button on the header. The user can click on the arrows to move the Tree View for the left/right
side of the screen, click on the refresh button to refresh the Tree View and on the pin-up button to fix the tree view on
the screen, so it won'’t close when the user open a Dashboard.

Click on the Project to select it, and then the user can:
- Create a New Project
- Open a Project
- Delete the selected Project
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On the Data Source, the user can:

- Create a New Data Source

- Edit the selected Data Source

- Delete the selected Data Source
The user can select a data Source, and add queries for it. With this application the user can add queries on a Design
mode, where the user can select the settings and the application will create the SQL for it, or the user can add a SQL
query manually, writing the Query on the designed box.

On the Dashboard the user can:
- Create a new Dashboard
- Edit the select Dashboard
- Add charts for the selected Dashboard
- Edit the default settings for the Dashboard skins

Instructions for creating and configuring a project are in the Configuration Section of this manual.

Main Screen

Business Intelligence Dashboard Template

Click here to install the Chart Control objects

On the Main Screen, the user can install the Chart Control Objects needed to open the dashboards, and access the
Proface website or send an e-mail to Proface.

Instructions for installing/uninstalling the Chart Components are in the next section.
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Installing and Uninstalling Chart Components

This section describes how to Install and Uninstall the Chart Components used on the Dashboard Application.

Click on the Link at the Main Screen to start the wizard for installing/uninstalling the Chart Components

Installing the Chart Components:

1- Open the Wizard to install the Chart Components on the Main Screen of the application.

ﬁ StudioControls

Welcome to the StudioControls Setup Wizard A

The inztaller will guide you through the steps required to install StudicControls on your computer.

WARMIMG: Thig computer program is protected by copyright law and international treaties.
IInauthaorized duplication or distribution of this program, or any partion of it, may result in severe civil
or criminal penalties, and will be prosecuted to the maximum extent pozzible under the law.

| Cancel < Back

2- Click on Next, and the screen to select the Installation Folder and the users on the computer that will have the
Control Components installed.
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3-

ﬁ StudioControls l — | |_i?-l
Select Installation Folder Al
P |
The installer will ingtall StudioControls bo the following folder.
Toinstall in this folder, click "Mext". To install to a different folder, enter it below or click “Browse"',
Folder:
C:\Program Files [#86\StudicContralsh S tudioContrals' [ Browse. .. ]
| DiskCost. |
Install StudioContrals for yourself, ar for amyone whao uses this computer:
) Evervone
@ Just me
Cancel ] [ ¢ Back ] [ et » ]
Select the Folder for the installation and click on Next, and then on Next again.
ﬁ StudioControls l = | |_i:?-l

Confirm Installation

The inztaller iz ready to install StudicControls on wour computer.

Click "Mest" to start the installation.

Cancel ] [ < Back ] |

Mest =
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r -
ﬁ StudioControls I. = ﬁj

Installing StudioControls N

StudioControls is being installed.

Fleaze wait. ..

4- Wait until the Control Components are installed

L

T —

ﬁ StudioControls e .

Installation Complete A

StudioControls has been succeszfully installed.

Click "Cloze to exit.

Pleaze uze Windows Update to check for any critical updates to the MET Framewark.
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5- The Chart Components were installed; Click on Close to exit the Wizard. They user may need to re-open the
application to start using it.

Uninstalling the Chart Components:

1- Open the Wizard, select Remove StudioControls and click on finish.

rj{-;‘;! StudioControls I. a— | |i:hl1

wWelcome 1o the StudioControls Setup Wizard LA

Select whether pou want ta repair or remowve StudioControls.

1 Repair StudioControls

@ Femove StudinControls

2- Wait while the StudioControls are removed.

rﬁ‘;’ StudioControls I. — | |&r

e

Removing StudioControls LA

StudicControls is being removed.

Pleaze wait. ..

¢ Back Mest »
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3- If the following screen shows for the user, close the application and “Try Again” or click on “Continue” to
uninstall the Control Components.

4 StudiaChartControls Files in Use e

The following applications are uzing files which the installer must remove. 'ou can either cloge the
applications and click "Tm Again'’, or click "Continue zo that the installer continues the
inztallation, and replaces these files when vour systen restarts.

Wiewer exe [Process 1d: 3124]

| Trw Again | [ Lontinue ] [ Exit Inztallation

L

4- Click on continue to finish uninstalling the Control Components

=

rﬁ StudioControls l — | ml

Installation Complete LA

StudinContralz haz been successfully removed.

Click. "Cloze" o ext.

5- The Control Components were uninstalled; Click on Close to exit the Wizard. If the user opens the application
again, it's necessary to install the Control Components before using it.

L
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Configure User Settings

This section describes the Configure Users System. To open the Configure Users Screen, click on the Configure
Users button in the Header. If there’s no user logged on the application, the button will show as Switch User, so you
need to logon before configuring the users. The configure users screen is only available for users with the security

system requirements.

Configure Users Screen

On this screen you can see a list with the users configured for the application, the user selected from the list, and the
user logged on the application. You can see the status for the selected user, and when the password for the logged

user expires.

i Configure Users

— =)

List of users current avaiable in the system: All Users -
D | User Name | Group Name
1 |‘ Guest | Guest
2 user User
3 admin Administrator

Selected user

User name: ‘Guest

Group name: ‘Guest

|o User avaiable

Modify
Password
Create new
User

User name: ‘admin l

Current User logged on

Group name: ‘Adm\nistrator

Password never expires l

r_\or_\ Switch User...l ‘ Close ‘
= =1

On the Configure User Screen, you can:
- Create a new User
- Modify Password
- Block User
- Remove User

- Switch User

Page 10/44




Business Intelligence Dashboard Template

Doc. Revision 1.71

Create New User

1-  Click on the Create New User button to open the following screen:

i -
& Create User @

L)

Uzer Mame:
U=er Full Marme:
Hew Paszward:

Confirm Pazzwaord:

Available Groups: Azsigned Groups:

Adrniniztrator
|zer

<

The name cannot be used. Mames may not be empty,
or congigt of peniods and/or spaces, or contain these
characters: . /"[]:[<>+=;, 7@

o) [Cmea)

2- On this screen the user can input the new user settings, and select the group for the new user. After selecting
the user name, password and group, click on the Ok button and the new user will be on the list.

i 5
& Create User @

User Mame:  Demo User
Uzer Full Mame:
Mew Pagzward:

Confirm Pazsward:

Avallable Groups: Agzigned Groups:

Adriniztrator

The 'User Full Mame' iz an optional zetting used for
documentation purpozes only.

] ] [ Cancel
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Modify Password

1- Click on the Modify Password button to open the following screen:

2 Set User Password I&

User Mame: |Guest

Current Pazsword:

MNew Pazzword:  see

Confirm Pazswaord: s

[ Ok ] [ Cancel

2- On this screen you can change the user password, give the current password and the new password, click on
the Ok button and the password is changed.

Block User

1- Click on the Block/Unblock User button, and you’ll see the following message:

i -
Block User .

Blocked users are not removed from the system, but cannot log on
! % until they are unblocked.
Are you sure you want to block the user user?

Yes Mo

2- When a user is blocked, you'll see his status as:

S User BLOCKED!

3- If you block one user, it won'’t be able to log on the application, until it's unblocked.
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Remover User

1- Click on the Remove user button, and you’ll see a message asking if you’re sure about this.

. -
Remowve User l Fad "']

This command will remove the user user permanently from the system.
l . Areyou sure you want to proceed?

ve || N

2- Click on Yes, and the selected user is removed from the application.

Switch User

1- Click on Switch User, and the Log On popup opens:

7 Log On (|
Current user; adrmin
User Mame:
Pazzword:
oK. Cancel | | LoaOff

2- Use the Log On popup to change the user connected to the application or to Log Off the current user.
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Creating and Configuring a Project

This section describes how the user can Create and configure one Dashboard project, with instructions on how to use
the application to select the Data Source, create the Queries and Dashboards.

Creating a Project

Select the current project on the Tree View and click on the new button to open the following popup:

3 Dashboard Project -> New lﬁ

Create a new Dashboard Project

Project Name:
| Project Demo 7,

Ol ‘ ‘ Cancel ‘

The user can type the project name on the text box, or click on button on the right side of it, to open the Data entry
popup. Type the New Project Name and click on the Ok button to create the project.

Remove Project

The user can click on the Remove Button on the Tree View to remove the selected project from the application. The
user will receive a message to confirm if the project should be removed.

r—D».=_=I|Eh.=_' l — ]1

"-.I Are you sure you want to delete the Dashbeoard Project: 'Project Demo’
2

I Yes | ’ Mo
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Open Project

The user can open one existing project clicking on the Open button. A popup with the existing projects list will open,
where the user can select one project to open.

Select the Project and click on Ok to open it and all its settings.

:# Dashboard Project -> Open [

Select the Dashboard Project

Project Name
Project 1

Project Demo

Ok ‘ ‘ Cancel

L - [ & = B I S T A T—
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Create a new Datasource

After creating a project, the user can add one datasource to it, by clicking on Datasource, and then on the New button.
The following popup opens, where the user can create the Connection String to the Database server.

3 Data Source -> New lﬁ

Create a new Data Source

Data Source Name:

| Demo Source]| ﬂ

| Connection Type:

I @ MS Access Database O 5QL Server Database
I Connection Stnng:
Frovide=Microsoft Jet OLEDB 4.0;Persist Secunty Info=False J
I
‘ Ok ‘ ‘ Cancel ‘

The User can type the Data Source name, and select the connection type; the user can use a MS Access Database,

or a SQL Server Database. After selecting the connection type, click on the J button to open the connection string
screen. On the Connection String screen, the user can select the Database for the data source, and give the password
to connect this Database if there’s one.

For this example we’ll be using the MS Access Database type, with the DBDemo database on the application folder.
The user can use the Test Connection button to test if the connection to the Database is working or not. If a data
source is created with an invalid connection, you can see that there’s a failed connection on the Status Bar and the
Database Status screen of the application.
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(&5 (nk Propetc

E5n G ot

Connection | Advanced | Al

Provider | Connection | Advanced | All

Specify the following to connect to Access data:

1. Select or enter a databaze name:

2. Enter information to log on to the database:

User name: Admin

Pazsword:

Blank password [ Allow saving passward

[ Test Connection

)

Specify the following to connect to SQL Server data:
1. Select or enter a server name:

SBSP2012000005 -

2. Enterinformation to log on to the server:
@ Use Windows NT Integrated security
1 Use a specific user name and password:
zer narme:
Pazzward:
Blank passwaord Allow saving password
3. @ Select the database on the server:

() Atach a database file as a database name:

Uzing the filename:

[ Test Connection

]

_oc |

Cancel ] [

Help

Cancel || Hebp

After creating a Data source, the user can select it and click on Edit to open the screen where he can change its name,

connection type and connection string.

New Table Query

Select the data source created, and click on the New button at the tree view, a popup will open where you can select
the type of the Table Query you want to create. The user can select between the Design Mode, a screen where he can
select the settings for the Query he wants, or the SQL Mode, a screen where the user can input the SQL Query he

wants manually.

Menu Panel +y

M Projeto Demo

=, Data Sources

$, =1| A Table Query -> Type

=

Design Query

* B
%ﬂ e

SAL Query
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Design Mode

On the Design Mode the user can interact with the screen to create a Query from a table. Select one table from the

Available Tables list, and click on the “>” button to add the table to the list for the query. The user can click on the
Refresh Table List button to refresh the list of Tables from the Data source.

i Table Quary - Design View v m M - - - R - @1
| Create a new Design Query
Query Name:
| Design Query 1 ﬂ
Data Source:
| Demo Source J
Available Tables: [Show Columns Selected Tables: [1Show Columns
|J; Demo Source
Tables
Views
Refresh
Table List
Columns: SaL:
Column Aggregation Alias
Ok ‘ ‘ Cancel
Add Column

Click on the Add button from the Design screen to open a popup where the user can select the column he wants to
show in the Query. If no column is selected, the query selects all the columns from the table.

On the Add Column popup, the user can select the column he wants to show, an aggregation for it (for example, the
Sum or Avg SQL functions) and put and Alias for the column selected.
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-

A Table Query -> Design View -> Column -> Mew

Add a new column

Table:

Table1

Column: Aggregation:
Id - MNone

Alias:

Ok

‘ ‘ Cancel ‘

Add Filter to SQL Query

The user can add a filter to the SQL query by clicking on the Filter button. The following screen opens:

-

i) Table Query -> Design View - Filter

Configure the filters for the selected query

Logical Column Operator

Value

Close
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Click on the add button to open the popup where you can select the settings for the filter.

:# Table Query -> Design View -> Filter -> New [

Add a new filter

Table:
Table1

Logical: Column: Operator:

Mone * d - < -
Value:

Ok ‘ ‘ Cancel ‘

L9

Select the settings for the filter and click on the Ok button to add it to the SQL Query (for example, you want to filter the
Query by the ID Column, where values are “>“then 5, select the Operator “>” the Column ID and put the value you
want in the text box to add these settings to the filter). The Value text box can’t be blank, and for the first Filter for the
Query the logical type should be ‘None’.

You can click on the Edit button to change the settings of the filter, or on the remove button to delete the selected filter
from the SQL Query.

Add group to SQL Query

The user can group the SQL Query by clicking on the Grouping button. The following screen opens, where the user
can Add, edit, or remove the Group from the SQL Query. Click on the Add button to open the popup where the user
can select the Column to Group by. To Group the Query by a column, the user should have used an aggregation on
one of the selected columns, or the SQL query won’t work
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i Table Query - Design View -> Group @

Configure the groups for the selected query

Aggregation Column

Close
On this popup the user can select the column to be grouped.
[ i Table Query -> Design View -> Group -> New ﬁ1
Add a new group

Table:

Table1

Column:

Id -

Ok ‘ ‘ Cancel
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Add Sort to SQL Query

The user can click on the Sorting button to add a sort to the SQL Query to order it. The order can be Ascending or
Descending, for the column configured on the sort screen. Click on the Add button on the Sort Screen to open the
popup where the user can select the column that will be used to order the Query.

Select for example the ID Column with an Ascending orientation to order the query by the ID values, from the lower to
the highest value.

i3 Table Queny -> Design View -> Sort -> Mew Iél

Add a new sort

Table:

Table1

Column: Direction:

Id - Ascending -

Ok ‘ ‘ Cancel

b

Preview Query

The user can click on the Preview button at the Design View Screen to see a table with the preview for the selected
Query.

[ A Table Query -> Design View -> Preview Iél1
Preview for the selected query (up to 100 Columns)

1D Id MName Value TS -
1i 1 Jan 1 1/1/2012 1:00._.
2 2 Feb 2 1172012 2:00.__.
3 3 Mar 3 1/1/2012 300
4 4 Apr 4 1172012 4:00__.
5 5 May 5 1/1/2012 500
6 B Jun 6 1/1/2012 600 . 3
7T Jul T 1/1/2012 7:00__.
& 8 Aug & 1/1/2012 8:00__.
9 9 Set 9 1/1/2012 9:00._.

10 10 Oct 10 1/1/2012 10:0__.

11 11 Mow 11 1M1/2012 11:0_ .

12 12 Dec 12 1/2/2012 110 i

Close
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If the query created is not working the user will see and empty screen and can find the error message at the Output
Window on Proface, or receive an error message from the application.

Update SQL
The user can click on the Update SQL button to refresh the SQL Query, if any change made doesn’t show on the

screen.

SQL Mode

On the SQL Mode the user can input the SQL Query manually on the text box. Check the Show Columns box to show
the columns from the tables. After creating the SQL Query you want, the user can click on the Preview button to see
the result from the Query.

A Table Query -> SQL View — =5

Create a new SQL Query

Query Name:

| 5QL Query 1 z

Data Source:

| Demo Source

Available Tables: [C]Show Columns SQL Query

[, Demo Source Select * From Table2 Where ID Between 7 and 25

9 Tables

Preview. ..

Ok ‘ ‘ Cancel ‘

Note: The Application adds the Top 32000 clause to all the Queries, so the user needs to modify the query to use the
Top Clause as in the screen below. The maximum number of rows that the user can see is 32000.
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i3 Table Query -> SQL View

Query Name:

Create a new SQL Query

| SQL Query 1

Data Source:

‘ Data Source 1

ﬁ

Available Tables:

[ Show Columns SQL Query:
I;_%; Data Sourcel Select* from [Select Top 10 * From|Invoices) as Thl
-- , Tables
[, Views

o ||

Cancel ‘

Create a new Dashboard

i Dashboard -> New

After creating the Data source and the Queries for it, the user can create a Dashboard for those queries. Click on
Dashboard at the Tree View, and on the New button to open the following screen:

=

Dashboard Mame:
Dashboard 1

Access Level:

Create a new Dashboard

All Users

Ok ‘ ‘ Cancel ‘

Page 24/44



Business Intelligence Dashboard Template

Doc. Revision 1.71

On this screen the user can select the Dashboard Name and the access level for it (if all users can see this dashboard
or only the user that created it) and the number of objects and the way they’re distributed on the screen. The
dashboard can have up to 4 objects, click on the “>>” or “<<” buttons to change the selected style for the Dashboard.
After selecting the settings you want for the dashboard, click on the Ok button to create it, and it'll show on the Tree
View. And Open the Dashboard Screen for the created Dashboard.

After creating a new Dashboard the user can add the objects to it. Click on the object at the screen (if there’s no object
configured for it) or click on the object at the tree view and then click on the Edit button.

Menu Panel bl =
A Projeto Demo
Data Sources
. Dashboards
-] Dashboard 1
®gf1 - None
W1 2-MNone .
Object 1 (Blank)
Object 2 (Blank)
|l
ﬁ Edit
X

Clicking on the Edit button opens the Edit Objects screen where the user can select the Name and Query for this
object. After selecting the Query, the user can decide on the object type.
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Edit Dashboard Object

Object Mame:

| i

Table Query:
I Mone _I

T Object Type:

[ B Pie chart ( olli Barchart ][ il Pareto chart

] ]
(OF wem |(om e |(omwe ||

Ok ‘ ‘ Cancel

Select one of the Table Queries created on the Datasources to create an object.
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Object Types

Pie Chart

Select the Pie Chart object to create a Pie Chart for the selected Query. The user can decide on the Column for the
Labels/Values for the chart and the Pie Chart Skin.

~Object Type:
o ) Y g ey
@ @ Pie chart ® \ﬂ Bar chart ® \ﬂ Pareto chart
% A% FLY A
. Y Y ey
(== Line chart ® 1 Table ) @' None
v AW FLY A
Labels: Values:
MName - Value -
Skin:

Flat Colored + White Background s

Pie Chart

Jun
Jul
Aug
Set
Ot
Mo
Dec
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Bar Chart

Select the Bar Chart object to create a Bar Chart for the selected Query. The user can decide on the Column for the
Labels/Values for the chart and the Bar Chart Skin. It’'s also possible to select [All columns] for the Bar chart. This
option will plot all columns from the query into the bar graph, except the one used as label. Note that some columns
might be unavailable due to its values.

Object Type:

4 Ny Ny N
O \29 Pie chart @ glly Bar chart (|34} Pareto chart

. 7N 7N v

4 ) ) Ny Ny N
(2= Line chart O ] Table ) &' None

. 7N 7N v

Labels: Vaues:

Day v ActualValue v

SKkin:

3D Yellow + White Background v [ JAll Columns

Bar chart example

Bar chart example
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Pareto Chart

Select the Pareto Chart object to create a Pareto Chart for the selected Query. The user can decide on the Column for
the Labels/Values for the chart and the Pareto Chart Skin.

Ohbject Type:

[3 Pie chart ][ gy Bar chart ][n@ Pareto chart]

[':' :_*;*_” Line chart ][_ Table ][ = None ]

Labels: Values:
Name] - \Value] -
Skin:

Flat Blue + White Background -

Pareto Chart

100%

-90%

180%

~70%

-60%

150%

~140%

30%

420%

410%

Line Chart

Select the Line Chart object to create a Line Chart for the selected Query. The user can decide on the Column for the
X Axis for the chart and if the X Axis is Numeric or Date/Time. If you use a Date/Time Column for X Axis and a
Numeric type, or a Numeric Column with Date/Time type, you’ll have a Blank Line chart.

Object Type:

'l N SN =
) ._/B Fie chart ) \ﬂ Bar chart ) \ﬁ Fareto chart

% AL A % r

- N N7 ™

@ "= Line chart @ 1 Table () &' None

%, FLN FLN A

X As: X Aus Type:

Day - I -
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Line Chart

RIQEQQ xEDEE @
25.00

7.00
25.00

200

7.00 25.00
~ Label Cursor Count Min Value  Max Value Average Std Dev

ael £ ge

PV N 7.00 18 7.00 25.00 16.00 5.48
N7 ] Aduavalue 2.00 19 2.00 25.00 10.05 629

Table

Select the Table object to create a Table for the selected Query.

0} Day ActualValue

7 7

9 9 8
10 10 12
11 11 20
12 12 2
13 13 7
14 14 16
15 15 18
16 16 10
17 17 9
18 18 8

None

Select None to leave the object with a blank screen.

Object 2 (Blank)
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Generate Report
This section describes how the users can Generate Reports, with instructions on how to Save and Print the reports for

the selected Dashboard. To access the Report screens, the user have to open one of the dashboards, and then the
Report button on the header will be enabled.

-
'L" D'I Home Screen

d (&) . _ L
_‘;J Dashboard HLg] Report ggConﬂgur?e Users H » ol Exit Application

04/11/2012
Dshboard 1

Click on the Report button to open the Reports screen, where the user can generate, save, and print reports with the
charts from the selected Dashboard.

.
A Report

T m

Orientation: Repor‘t Viewer

Porirait -

F Repeat Header in
each page

PROJECT DEMO
DASHBOARD 1

Created on 04/23/2012 08:51:12

Objects per Page:

m

"‘-‘é Print

Print
N Preview

Close |

On the Report Screen the user can see a preview from the report, and the report control buttons.
Report Control

Orientation:

On the orientation box, the user can choose between Portrait and Landscape for the Reports style. Change the
orientation in the box and click on generate report to see the report with a different orientation.
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Note: The user have to manually select the orientation before printing the report, the orientation on the Report Viewer
is just for a preview of the Report.

Repeat Header

The user can check the Repeat Header in each page to generate reports with a Header for every page. If this option is
not checked the report will have a Header only in the first page.

Objects per page

The user can choose between 3 options for the number of objects in a reports page. The user can generate reports
with only one, two, or four charts on each page. If the dashboard has two objects and the report is set to have four
objects on each page the report is shown as the image below (Orientation set to Landscape).

PROJETO DEMO

DASHBOARD 1
Created on 04/11/2012 08:43:37

If the dashboard has a table configured in it, the table shows at a new page, so for reports with 4 objects in a page, the
first page show 3 objects, and there’s a second page for the Table.

Generate Report

After the user selects the number of objects per page, orientation and if there’s a header on every page, use the
Generate Report button to refresh the report preview with the new configurations.
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Save Report

The user can save the report clicking on the Save button. Click on the save button and select the directory where you
want to save the report.

Print Report

The user can print the current report clicking on the print button. The users have to manually select the orientation on
the print screen, and configure the margin.

Print Preview

Click on the Print Preview button to open the screen where the user can see the report before printing it.

Close

Click on the Close button to close the Report Viewer Screen.

Note: It's possible to change the Logo on the reports by replacing the ReportLogo.jpg file on the Web Folder. The new
logo should be named ReportLogo.jpg.
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Query variables

On the version 2.0 of the Dashboard Template, it's now possible to create variables in the application to use on a
query. The use of those variables will enable the user to modify one query faster, without having to change it directly,
and even modify all queries using this variable at the same time.

Menu Panel

+4

)

My TestVariables
EI Data Sources
P i Variables
- @14, DemoDB
= Dashboards
EI:D Demo Dashboard
EI B 1-Demel

----- : IE-DEMDE

F-® 3-Demo 3

‘ lél Edit

On the Menu Panel, it's possible to access all the variables
configured for a Project.

Click on the Variables node and on Edit to open a screen that
shows a list of all the project variables. From this screen it's
possible to create, edit or delete a variable.

If you select a variable directly from the Dashboard where it is used
in the Menu Panel, you can edit its value, and the dashboards will
be updated with the new values from this variable.

It's important to note that the variable names can’t have any special
character like * /[ ] @ or spaces in it.
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Configuring variables

To create or edit variables, open the screen below selecting the Variables node from the Menu Panel and clicking on
Edit, then select the variable desired.

8 Project Variables et A R ——— &q‘
Add or Edit Project Variables
Name | Type Value
DateStart | 3 1/1/2012 04:00:00
DateEnd 3 1/1/2012 6:00:00
||
Add ‘ ‘ Edit ‘ ‘ Delete ‘ ‘ Close ‘

Create a new variable

By clicking on the Add button, you can create a new variable in your project. As in the screen below, you should
configure a name, a type and a default value for the variable being created. There are two kinds of variables, the first
one have a fixed value, and its value is modified manually by the user. The second one is updated automatically,
based on the default value.

It's possible to select one of the variable types below:

Integer

Configure the variable to have an integer value that will be replaced in all the queries from the project using this
variable. This variable value should be updated manually.

Real

Configure the variable to have a real value that will be replaced in all the queries from the project using this variable.
This variable value should be updated manually.

Note: The current version of the Bl Dashboard doesn’t validate the decimal separator, so you should create the
variable with a separator compatible to the database and local settings.
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String

The string variable can be used as a normal string, or to create valid expressions with different variables. When
creating an expression, you can variables with their name between {} as {Variable 1} * {Variable 2}

Note that there’s no validation when creating an expression, so if an invalid expression is created, it’ll result in an error
when executing the query.

Date/Time

Configure the variable to have a valid Datetime/Date/Time value that will be replaced in all the queries. Valid values for
this variable are:

Date: 01/01/2012

Time: 10:00:00

Datetime: 01/01/2012 10:00:00

This variable value should be updated manually.

Tag Name

Configure the variable to use the value of a tag on the queries. When selecting this type, you need to use the name of
a valid tag as the default value, and when a dashboard is opened, this variable will be replaced by the value of the tag.

This variable is updated automatically, its value updated based on the tag selected.

Current Time

ts

Configure the variable to use the current time as a value on the queries. This variable is updated automatically,
value updated based on the time.
It's not possible to modify the default value for this variable.

Current Date

ts

Configure the variable to use the current date as a value on the queries. This variable is updated automatically,
value updated based on the date.
It's not possible to modify the default value for this variable.

Current Day

ts

Configure the variable to use the current day as a value on the queries. This variable is updated automatically,
value updated based on the day.
It's not possible to modify the default value for this variable.

Current Year

ts

Configure the variable to use the current year as a value on the queries. This variable is updated automatically,
value updated based on the year.
It's not possible to modify the default value for this variable.

Current Month

ts

Configure the variable to use the current month as a value on the queries. This variable is updated automatically,
value updated based on the month.
It's not possible to modify the default value for this variable.
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[ s |

Create a new Variable

Variable name
Variable name

Variable type

Integer M

Default value

1

Save ‘ ‘ Cancel

Edit a variable

By clicking on the Edit button, you can edit a variable from the project, modifying its value, type and name. If you
change the name of the variable, it is automatically replaced on the queries from the project, to avoid problems with
the queries.

Delete a variable

By clicking on the Delete button, you can delete a variable from the project. If you delete a variable used in a query,
you’ll need to update the query manually, or you’ll have an error on it.

Notes

Please note that the dashboards are not updated automatically if the value from any dynamic variable is modified. It's
necessary to open the dashboard again to update it.

The variable name have a limit of 19 characters.

The default value of the variable have a limit of 20 characters, so it's the size limit for an expression created using the
string type.
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Querying with variables

The variables created on the project can be selected when creating a filter on the Query Design Mode, or manually
inserted in the SQL Mode.

Design Mode

When creating a filter in the Design Mode, click on the B button on the screen below to open the variable selection
screen.

Select one of the variables from the list and click on Ok to use it on the filter. Note that if you used a variable with a
type not allowed for the column you're creating the filter, your query will not work and return an error if you click on
Preview.

i Table Query -> Design View -> Filter -> Edit [

Select a variable for the filter

Variable name

DateEnd
DateStart
Muml
Mum2

Sum

Ok ‘ ‘ Cancel
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A variable selected on a filter, will appear on the Value field as on the image below. If you already know a variable
name, you can add it to the filter by writing its name between {}.

i# Table Query -> Design View -> Filter -> Edit [

Add a new filter

Table:
Table1

Logical: Column: Operator.

And - Id - z -
Walue:

| {Num1} ﬂg

Ok ‘ ‘ Cancel ‘

SQL Mode

When creating a query on the SQL Mode, it's possible to use a variable writing its name between {} on the query, and
when the query is used the variable will be replaced by the correct value.

SQL Query
Select * from Table1 Where TS <#{DateStart}# Or TS = #{DateEnd}#

‘ Preview. . ‘
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Chart edition

On the latest version of the Dashboard Template (v2.2), it's now possible to edit the values of the variables used in a
chart query, refresh the chart and also select which columns will be available for some of the charts, directly from the
dashboard screen.

The list of columns visible is configured based on the current user, so different users can access the same dashboard
and the result for the charts may be different based on the user preferences. With the refresh option available, the user
no longer needs to close the dashboard and open it again to update the results.

Variable edition
Column customization
Refresh chart
Export chart to CSV = ;

1, &
None *+ i s
5.00
12.00
5.00
01/01/2012 01/01/2012
06:00:00 12:00:00
) & T Label Cursor Count Min Value Max Value Average 5Std Dev
/v Id 6.00 7 6.00 12.00 9.00 2.00
/v Value 6.00 7 6.00 12.00 9.00 2.00

Note: It's also possible to reload all the charts automatically, by changing the value of the tag ReloadAllCharts.
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Refresh

With the refresh button, the user can update the selected chart to show the current values, if there were any changes
in the query or results expected. There’s also a new refresh button on the menu panel, available when a dashboard is
selected, that will work on all the charts opened.

Customize Columns

With the option to customize columns, the user can now modify the resulting chart by opting to hide some of the
columns. This option is available for the line chart, table and bar chart (only when the option to use All columns was
checked).

On the right side the user can verify all the columns that are visible in the chart, and on the left side all the columns
that are hidden and available, so that it's possible to add them to the chart

Note: Some of the columns available might not be used, based on the chart object type.

= | Customize columns -

Customize object columns

Available columns Visible columns
Id Name
Value
TS

Save Cancel
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Edit variables

The last option available is to edit the variables used in the query for the selected chart. By clicking on the button, a

screen with a combo box with all the variables used in the query will be opened, and the user can then modify the
default value for each variable.

Edit variables

Variable name

Int2

Variable type

Integer

Default value
8

Cancel
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Export to CSV

When exporting the chart data to a CSV file, the screen below is opened, where the user select the name for the file
that will be created. After the file is exported, the Open button is enabled so the user can visualize the exported data.
It's also possible to open an old report file, by entering its name and clicking on Open.

Export dashboard object None to CSV

Report file name

Open

Cancel
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Application Notes

This section contains important notes about the application.

The user need the .Net Framework 3.5 + SP1 installed on the computer, so the .Net objects work successfully.
The users have to configure the margin before printing a Report.

The application has a limit of 32000 points, and the clause TOP is included in the Query. The user should not
use the TOP clause on a query.

The Order By clause should not be used on Line Charts, or the trend can end up with multiple values on the
same point.

When executing the application on the Web, with the default path not directed to the Web folder, the Tag
AuxServer.URL should be modified to point to the correct path, or some of the icons will not be available.
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